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L. OVERVIEW / DESCRIPTION

The Vermont State Archives and Records Administration (VSARA) uses Versatile Enterprise
Records Management Software (Versatile) to manage records stored in the State Records
Center by state agencies as well as records in the custody the Vermont State Archives. The
Versatile system has a web module accessible to records officers and liaisons that allows state
agency staff to access information about their records stored in the State Records Center and
submit box transfer requests.

The goal of this guide is to provide users with information on how to access the web module,
use it to search and view records stored at the State Records Center, and create new boxes
transfer to the State Records Center.

Utilizing the web module will allow you greater control and access to your agency or
department’s records, and will save time and effort for staff in your office and in the State
Records Center.

To use the Versatile web module, you must be a designated records officer or records
liaison for your office. Please see Designating Records Officers (VSARA0004) and
Appointing Records Liaisons (VSARAO0005) on our website.

You will need a Versatile user account and access to the internet via GovNet.

As a records officer or liaison, you may request a user account. You will be given a user
name and a temporary password.

For more information, contact us at sos.rim@vermont.gov or call 802-828-5385.



https://www.sec.state.vt.us/media/27755/VSARA0004.pdf
https://www.sec.state.vt.us/media/27758/VSARA0005.pdf
mailto:sos.rim@vermont.gov
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| I. VERSATILE BASICS

A. ORGANIZATIONAL STRUCTURE

Within Versatile, there are several levels of organization for all records stored in the State
Records Center. The top level is the company. Under each company there will be one or more
departments. Each department has one or more record series, under which records are stored
in the form of boxes or files.

Company
In Versatile, a company is roughly equivalent to a state agency. However, most agencies and
departments were originally gathered together in Versatile under one “umbrella” company,
VSARA. Now, companies reflecting the state’s agency structure are being created and records
are being moved under these companies. So you may need to look for your agency’s records
both under the company VSARA and any new company that may have been created for your
agency to use.

Department
Departments equate to the state department, division, business unit, or program to which
records belong. All departments fall under a specific company. Each department is represented
by a two- to five-letter ID code (e.g., ED for Education). This code will also serve as the prefix for
your department’s record series and UBNs (user box numbers).

Record Series
A record series groups together records with similar function or subject matter; these records will
also have the same retention policy. There can be many record series under a department.
Each record series number is prefixed by the department ID code (e.g., ED-001). Please note
that series under a newly created company may not be the same as those under the VSARA
company.

There is a specific retention period associated with each record series that is defined by either a
disposition order or a record schedule. All records under a record series will be retained and
destroyed in accordance with the retention period of that series. For this reason, it is very
important that records be stored under the correct series. Submitting records to the State
Records Center under an incorrect series can lead to the premature destruction of important and
irreplaceable records, or cause records to be unnecessarily kept past their appropriate retention.

Boxes
Most records in the State Records Center are stored in boxes, each with a unique identifying box
number. Boxes are stored under a record series, determined by the context in which the records
were created. The retention period for each box is assigned automatically from the record series
in which it is stored, using the end date of the material stored therein as the starting point for
calculating the retention.

Files
In Versatile, a file typically represents a roll of microfilm, CD, or other recording medium. A file
might be a roll of microfilm that is stored in a box; some films have also been stored
independently, with no box. (There are some paper document folders within a few boxes that
were designated as files under older procedures.)

-2-
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B. LOGGING INTO THE WEB MODULE
There are two ways to access the web module:

o Go directly to: https://versatile.sec.state.vt.us/recordsroot/default.asp, or
Go to http://www.sec.state.vt.us/archives-records/state-records-center/forms-
procedures.aspx, and click on “Versatile Web Module” from the Quicklinks box on
the right-hand side of the page.

The link takes you to the Login page.

.-', ‘VEH'SL—']‘_”E:
If@ Web ENTERPRISE

Vermont State Archives and Records Administration

Home Help Login

Versatile Web Login Page

This page provides access to Versatile Web. Please input your User Name and Password below.

Company: |VSARA v
User Name:

Password:

Company: Select VSARA in the drop-down list for Company unless you've been instructed
otherwise.

User Name: This is typically, although not always, in the format firsthname.lastname.

Password: The first time you log in, enter the temporary password you were given by the
Versatile administrator. You will have a chance to change it after you log in the first time.
For subsequent logins, just type in your password. Please note that the password for the
Versatile web application has no connection to your network (Windows) login password.

Click the Login button.

LOGIN PROBLEMS

If you see the message “Login failed! Bad Company/Username/Password” after you have
clicked the Login button, please reenter your information, making sure that Company, User
Name, and Password are all correct. (User Name and Password are not case-sensitive.)

Login failed! Bad Company/Username/Password.


https://versatile.sec.state.vt.us/recordsroot/default.asp
http://www.sec.state.vt.us/archives-records/state-records-center/forms-procedures.aspx
http://www.sec.state.vt.us/archives-records/state-records-center/forms-procedures.aspx
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Forgotten your password? Contact VSARA'’s Records Analysis Unit at
sos.rim@vermont.govor 802-828-5385, and we will reset your password.



mailto:sos.rim@vermont.gov
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C. LOOKING AT THE VERSATILE WEB MODULE
You are now at the Welcome (home) page. The top navigation menu shows these options:

Home (Welcome)

Creation (drop down to see Box Creation Requests and My Box Requests)
Retrieval (drop down to see Search Boxes/Files)

Record Series (drop down to see Retention Schedule)

Security (drop down to see Change Password)

Help (links to this manual)

Logout

@ "0 oo o

Note: The small triangle + next to a top navigation menu item (e.g., the = next to treation™ )
means that there is a drop-down with one or more items to select. Hover your mouse cursor
over the menu item to reveal the drop-down options, then click on the one you want.

y ‘ Versatile
b@ eb ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Security ¥ Help Logout

Welcome to the Web Module for the Vermont State Records Center
State records officers and liaisons can use this system to:

s+ access information about their records stored in the State Records Center
+ submit new boxes.

For help with the Web Module, please refer to Using the State Records Center Web Module (Procedure WSARADDO1Z).

More information about State Records Center procedures and forms can be found on our website.

Please feel free to contact us at recordscenter@sec.state.vt.us,
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D. CHANGING YOUR PASSWORD

If you are a first-time user, you should start by changing the temporary password you were
issued to a new password you create. You should not share your password or let someone else

log on with your user name.
On the top navigation menu, mouse over Security and then down to Change Password.

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Security ™ Help Logout
Change Pazsword

I Welcome to the Web Module for the Vermont State Records C%ter

Input your current ("old") password as provided by VSARA. Now type in the new password you
would like to use for login purposes. (You will be asked to type it in twice.) Passwords should
be at least five characters in length. Click Request.

y 4 |Vers-atite
b@ Web ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval™ Record Series™ Security ¥ Help Logout

Versatile Web Password Change Page

This page allows you to modify your password for the Versatile Web module.

Please input your current {"old") password as provided by VSARA. Then provide the new password you would like
to use for login purposes. (You will be asked to type it in twice.)

Old Password: |
New Password:

Confirm New Password:

If the new password and confirm password field contents don’t match, you will see a message
to that effect.

You will get a confirmation message once you have successfully changed your password.

Click on the “login” link in the confirmation message. (You may also click on Home and log in
from there, or on Logout and then Login.)
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|| M. SEARCHING FOR EXISTING RECORDS

Mouse over Retrieval on the navigation menu and select the Search Boxes/Files drop-down
option by clicking on it when your mouse causes it to change color.

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Securify ™ Help Logout
Search Boxes/Files

l Welcome to the Web Module for the %rmont State Records Center

The search page has Boxes checked by default. If you want to search on files (typically, reels
of microfilm), uncheck Boxes and check the Files checkbox.

Underneath those checkboxes, you will see three tabs: BASIC CRITERIA (default), BOX/FILE
CRITERIA, and ADVANCED CRITERIA. (You may combine filters from the different tabs before
conducting a search.)

To clear any previous search filters, click the Clear button.
Make sure that the appropriate box (Boxes or Files) is checked.
When you have set all your search parameters, click Search.

l/"j ‘ Versatile
RV VN ENTERPRISE
Vermont State Archives and Records Administration
Home Creation™ Retrieval ™ Record Series™ Security ™ Help Logout
Versatile Search
Search In: [“|Boxes []Files Results per page: |10 %
BASIC CRITERIA | BOX [/ FILE CRITERIA | | ADVANCED CRITERIA
Search Text: |
Help?

For any searches, you may customize the number of records shown on each page of the search
results. Clicking on the drop-down list to the right of “Results per page” offers you the choice of
10, 20, 30, 40, or 50 records shown on each page when you view the results of your search.
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A. BASIC CRITERIA

The BASIC CRITERIA tab offers a large text box that allows you to search on a key word or words,
such as when you're looking for something contained in a box or file description.

Note that the search text is not case-sensitive: “Corp”, “CORP”, and “cOrP” will all find the
same record set. (This also includes Boolean operators; see below.) Punctuation is not
significant.

SEARCH OPTIONS

Single word: just type it in and click on the Search button.

Phrase: you must enclose it in double quotation marks. Single quotation marks will not work.

| “tax returns”, not ‘tax return’ \

Boolean operators:

AND: returns records containing both words (or phrases contained in double quotes).

‘ “tax returns” AND “property tax” ‘

OR: returns records containing either of the words or phrases.

‘ tax OR “trust returns” ‘

NOT: returns records that do not contain the word or phrase.

trust AND NOT zero will return any records containing the word ‘trust’, but which do
not contain the word ‘zero’.

* (wild card): returns records with anything (or nothing) represented by the “*”. Note: double
guotation marks must be used! Also useful for multiple spellings or abbreviations,
combining the wild card with the OR operator.

“audit*” will return any records containing words that start with ‘audit’, including ‘audit’,
‘audits’, ‘auditing’, ‘auditor’, auditors’, etc.

“paid*” OR “pd*” will return any records containing ‘paid’, ‘paids’, ‘pd’, ‘pd.’, ‘pds’,
‘pds.’, etc..

You may combine operators in various ways; it's recommended to use parentheses unless you
are very familiar with the operators’ order of precedence.

property AND (transfer OR tax) AND NOT zero will return any records containing
‘property’ plus either ‘transfer’ or ‘tax’, but which do not contain ‘zero’.

You may also click on the Help? link below the text box. For some more specialized search
options, ask VSARA'’s Versatile administrator for assistance.
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B. BOX/FILE CRITERIA

y ‘ Versatile
b@ eb ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Security™ Help Logout

Versatile Search

Search In: [vIBoxes []Files Results per page: |10 [
BASIC CRITERIA BOX / FILE CRITERIA | ADVAMNCED CRITERIA

User Box Number: =]

Box Number(s): IF

File Mumber(s): [F

When entering multiple box numbers or file numbers, please =eparate each number with @ comma or a space. To list the
inventory of a specific box, enter a box number and then select the checkboxes to search in files.

The BOX / FILE CRITERIA tab enables you to search for boxes by User Box Number (UBN) or by
Box Number, and for boxes by File Number. Make sure that the appropriate box (Boxes or
Files) is checked for your search.

User Box Mumber: TH-44120|
Box Number(s): [l
File Number(s): ]

User Box Number: This is the most commonly used search. The UBN is the alpha-numeric
string consisting of a lettered prefix, a dash, and a five-digit number that is assigned to each
box in the Records Center. The prefix denotes the agency or department that created these
records. You may search on only one UBN at a time.

‘ Note: Be sure to pad the number with zeros so that there are five digits (e.g., PRA-00234). ‘

Box Number(s): This is the system-assigned six-digit box number; it can be found on box
labels and most box detail reports. You may search on more than one box number; separate
box numbers with commas or spaces.

File Number(s): This is the system-assigned file number. It can be found on microfilm or CD
labels and most film detail reports. However, it will probably be more useful to use the text
box under the BASIC CRITERIA tab and enter the user file ID number (e.g., F-04811).
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C. ADVANCED CRITERIA

y4 ‘Ver‘satiie
ll@ Web ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval™ Record Series™ Security™ Help Logout

Versatile Search

Search In: [v]Boxes []Files Results per page: | 10 %
BASIC CRITERIA | | BOX / FILE CRITERIA | ADVANCED CRITERIA
Company: il VEARA v
Department: O [vszra *
Include Sub—Departments%
Record Series: | @ None
Content Dates (MM/DD/YYYY): | o i

To list the inventory of a particular company, department or record series, check the box next to the appropriate item(s) and
zelect yvour search criteria. By choosing only a record series and selecting the checkbox to search in boxes, the results will list all
the boxes in the specified record series.

Click on the boxes next to the fields you would like to search:

Company: The company or companies you see available to you on the drop-down list are
determined by your agency'’s or department’s Versatile security group. You may select only
one company at a time. (If you find that the web module does not default to your company
or department, please contact VSARA at sos.rim@vermont.gov to have your user account
updated.)

Department: Once you have selected a company, you may then select a department. Sub-
departments are included by default (box is checked). A window pops up, within which you
may see the departments available to you by clicking on the list & button:; click on any of

those listed. You may also click on the search & button to do a text search on the
department name.

Record Series: You may further specify your search by selecting a record series. This is
where you are most likely to need to make a selection. You may use either the list I= button
or the search B button to select a record series.

Content Dates: You may also search for boxes containing material within a certain date range.
The box’s “From” and “To” dates provide the start and end of the range. You may choose to
combine searching on the company, department, or record series as well as the content
dates, further narrowing down your results set.

01/01/2000 to 12/31/2000 will return any records where the “From” and “To” Dates of
the box or film include that date range.

-10 -
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D. SEARCHING FOR YOUR BOXES

When you are done creating the search filters or parameters (from one tab or multiple tabs),
click on the Search button.

For any searches, you may click on the Clear button to get rid of any previous search filters.
Remember, however, to check Boxes (or files, or both).

Search In: Boxes [ |Files

Otherwise, you will get an error message reminding you to do so.

E. UNDERSTANDING SEARCH RESULTS

The Search Results page gives you the information you requested as well as ways to customize
and save that information.

“Search Results for” restates your search parameters.

“[num] Physical Record Entries found” gives you the number of records in your results set.
The default number of items per page is set at ten, so you may have more than one page of
results.

You will then see a listing headed with the column (field) names. Those are set to User Box
Number, Department ID, Record Series, Description, and the From and To content dates for
each box.

y4 |Ver5:atite
'/@ Web ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Security ™ Help Logout

Search Results CONFIGURE

Search Results for:
Searching in Boxes where company is "WVSARA' and department starts with 'TAX' and record series is 'LITIGATION FILES' and
content date between 01/01/2000 and 12/31/2000

27 Physical Record Entries Found

(Prints all 27 items)

Result pages: 1 2 3 [»] [>=]
Itemns displayed : 1 to 10 (10 items per page)

User Department Record Description From To

Box D Series

Number j 0]
& TX-37118 /TH/ 031. Commissicner's Files 01/01/1984 12/31/2003
i' TX-37119 JTX/ 031. Commiszioner's Files 01/01/1984 12/31/2003

& Tx-37120 JTX 031. Commissioner's Files y 5 3 01/01/1984 12/31/2003

-37126 [TX/ 031. Commissicner's Files 01/01/1984 12/31/2003

g T

i' TX-39972 JTX/ 031. COMMISSIONER'S FILES 1-1/33-6-99 EXCWV 01/01/1989 12/31/2008

Sort By: | User Box Number (%

-11 -
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F. CUSTOMIZING SEARCH RESULTS

You can customize your search results by changing the sort order; by adding, deleting, or
moving column order; or by changing column widths. (As mentioned earlier, you may change
the number of items shown per page, but this must be done on the search page; it is not
available to change on the search results page.)

Sort: The drop-down list on the bottom right-hand side of the page, underneath the list of
records returned by your search, shows the sort order. Choose the field you want to use for
your search order, and click the Refresh button.

From To

DONIA, Deparment 1/2000

Department ID
in on 6/23/Barcode 1/2000
12/2007 |Description

Record Series ID )

Record Series 1/2000

Storage Room ID

Storage Room 1/2003
Submitted By .

e 1/2003
Created
Event 1/2003
Submit
Misc 1/2003
From
To 1/2003

Box Number ;
Fecord Center 1D 1/2003

User Box Number

Itemn Index 1/2003

Record ID

Sort By: | User Box Number |v

Configure: click on the Configure button on the top right of your search results page. This
opens the Configure Search View window.

Versatile

i
l/@ ‘ We ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Security™ Help Logout

Configure Search View

Column Name width
User Box Number 55 €]
Department ID 25 (@) (@
Record Series ID 25 (@ (@
Description 347 (&) (m
From 25 @ @
To 25 @

In Use: 502
RESET
Available: 702

Column: Width:

Barcode e 50

-12 -
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The Column Name column displays the fields you saw on the Search Results page, along with
their width (in characters) and the order in which they appear (left to right) on that page.

You can add a field from the Column drop-down list underneath the list of the currently
displayed fields, and specify the desired display width. Click the Add .22 button

Column: Width:

Box Number e 20
Barcode %

Created

Department

Record Center ID
Ewvent

Submit

Misc

Record Series
Storage Room ID
Storage Room
Item Index
Submitted By
File I

Box Full? (Box)

You may choose to remove displayed fields by clicking on the Remove 2/ putton to their
right.

Column Name Width
User Box Number 55 =
Department ID 75 (&) [z

The fields’ display order can be changed by clicking on the up () and down (= buttons to move
them up and down relative to the other fields chosen to display.

Reset (bottom right of page) returns the display to the default fields.

When you are finished customizing, click Done “2£. (bottom of page). This returns you to the
Search Results page.

-13-
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G. PRINTING OR SAVING SEARCH RESULTS

Print or email: Clicking Print/Email Results, on the right-hand side of the page, allows you to
print your results set (the entire set, not just the items appearing on that page). This opens a
separate Print Search Results window.

& http:fiprod-versatilef - Printable Search Results - Microsoft Internet Explorer p... E]@|E|

Fil= B=u#¥ Yiew Favarites Tools  Help
~
ﬁ Print or Email Search Results for:
Searching in Boxes where company is "VSARA' and department starts with
'TAX' and record series is 'LITIGATION FILES' and content date between
01/01/2000 and 12/31/2000
User Department Record Description From To
Box ID Series
Number 1D
TX-37118 /TXS 031. Commissioner's Files 0170171984 12/31/2003
TH-37119 /Tx/ 031. Commissioner's Files
TH-39974 [TH/ 031. COMMISSIONER'S FILES 1- 01/01/1989 12/31/2008
1/33-6-99 EXCV
TX-39975 /Tx/ 031. COMMISSIONER'S FILES 01/01/2000 12/31/2004
CORRESFONDENCE
TX-40439 /Tx/ 031. RECORDS TRANSFER LISTS 01/01/19388 12/31/2008
AS STATS
TH-40441 /TXS 031. BUDGET AND Y2K 01/01,/1997 12/31/2006
INFORMATION
TH-40443 /TXS 031. BUDGET BOOKS 01/01,/1988 12/31/2006 b
4 | >

The link & Print or Email Search Results for:”, when you mouse over it, shows information about
how to print or email.

Print or Email Search Results for:

Searchi lick here to print details. To is 'VSARA' and department starts with 'TAX'

and rec ) ) P ; : ate between 01/01/2000 and 12/31/2000
email, click the "File" menu

User and select the Send->"Page From To

Box By Email" menu option.

Number D

PVR- JTHS 062. CRIGIMAL CD ESSEX, 04,/01/1999 12/31/2000

Annen AR EAMS Al ERAMTA

To save information: You can also export this information into another document by selecting
and copying. From the menu bar, select Edit > Select All; Copy. You can then paste this
information into its desired destination, such as an Excel spreadsheet or Word document.

To print: Click on the Print or Email Search Results link. The Print window opens up; choose
your printer (or PDF option, if you have that as one of your listed printers) and proceed as usual.

To email: From the menu bar, select File > Send > Page by E-mail

-14 -
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Edit  Wiew Favorites  Tools  Help

Mew Tab Chrl+T

Duplicate Tab Chrl+k -

e Window Chrl+m

Mew Session pany is "VSARA' ant
Open... Chel+0 ATION FILES' and
Edit with Microsoft Office ‘Word

Save Chrl4+5

Save As... ription

Close Tab Chrl4+

Page Setup... nissioner's Files

Print... Chrl+P nissioner's Files

Print Previgw. ..

nissioner's Files

[ Page by
Import and Export... Link by E-mail. .. %
) Sharteut bo Deskkop
Properties
‘Work OFFling nissioner's Files
Exit nissioner's Files
e : T e TRRTANFR 'S FTIFS 1.

This will bring up a new message in your email client (probably Microsoft Outlook). You will see
your results set in the message body. Then just address and send your email. You can copy
and paste the information contained in the email into a spreadsheet or other document.

3 Emailing: Printable Search Results. htm - Message [HTML)

i File Edit Wiew Insert Formak  Tools  Actions  Help

-Eisawﬂﬂ@;; EEN YRR R R

2] Cptions... | @ &

i Verdana

Emailing; Printable Search Resulks,htm |

|3

lsearching in Boxes where company is "VSARA' and department starts with 'TAX'
and record series is 'LITIGATION FILES' and content date between 01/01 /2000
and 12/31/2000

User Department Record Description From To

Box ID Series

Number 1D

TX- STHS 031. Commizzioner's Files 01/01/1984 12/31/2003
37118

T [T 031 Commissigner's Filee 0i/01/1984 123172003
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V. SUBMITTING NEW BOXES TO THE STATE RECORDS CENTER ||

A. GETTING STARTED

As a records officer or liaison, you can use the Versatile web module to submit new boxes
directly to the State Records Center, rather than preparing and sending records transfer sheets.
This can save you and the Records Center staff time and effort.

Before you begin using the web module to submit boxes, be sure to follow the procedure for
Transferring Records to the State Records Center (Procedure VSARA00008).

A Records Pickup Request (VSARA-04) or Records Delivery Request (VSARA-028) must be
received and approved by the State Records Center Supervisor before any boxes can be
transferred to the State Records Center.

You may have become aware, when looking at your existing records in the State Records
Center, that only the information that your department submitted when sending these boxes is
available for you to use when searching. The more detailed information you include when you
create boxes, the more useful a tool the Versatile web module can be.

Once you have contacted the State Records Center Supervisor and received your box numbers,
log in to the web module.

B. CREATING A BOX REQUEST

At the Welcome (home) page, select Creation > Box Creation Request from the top navigation
menu.

ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval ™ Record Series™ Security ™™ Help Logout
Box Creation Request

for the Vermont State Records Center

[ Welcon| My Box Requests

You will now see the Box Creation Page. It will look somewhat similar to the ADVANCED
CRITERIA search tab.

Please be sure to have the correct User Box Numbers and Record Series before you begin
creating and submitting new boxes.
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ENTERPRISE

Vermont State Archives and Records Administration

Home Creation™ Retrieval v Record Series™ Security ™ Help Logout

Box Creation Page

VIEW SAVED DRAFTS

If you do not know the User Box Numbers assigned to you, or are unsure which Record Series
you should use, please contact the Records Center at 828-3280 or RecordsCenter@sec.state. vi.us.

Company: * VSARA RV

Department: * B JTX/ - TAX

Record Series: * B None

User Box Mumber: *

Type of Box: * STANDARD (2 POSITION) v
Storage Center: * MIDDLESEX RECORD CENTER |+
From Date (MM/DD/YYYY): * g

To Date (MM/DD/YYYY): * 3|
Description: *

Box Full: F

((SuBMIT BOX ) {SAVE AS DRAFT) (_CLEAR ] 012

* Required fisld

Company and Department: Select the appropriate values, as previously described under the
ADVANCED CRITERIA tab of the Search page. You may have one or more companies
available to choose, which will affect which departments are available. You can use the list

= putton to view your choices, and then just click on the option you want to select.

& http:H{prod-versatile/? formname=boxdatafi parentpage=5%2Frecordsroot%2F...

Current Department: /TX/ - TAX

Selecting a new company should bring up the appropriate department(s) under that company.
If that does not happen, click the CLEAR button next to “Current Department”. The
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Department on the Box Creation Page should now show as “None”. Then click on the list =
button again to select the department for that company in the pop-up window.

Record Series: Ensure that the record series matches the types of records in your boxes. If
needed, refer to the series’ corresponding disposition order or record schedule to
understand the retention requirements. Your agency’s records officer should have copies of
all disposition orders or record schedules in current use. You may also check online at
https://www.sec.state.vt.us/archives-records/records-management/records-retention.aspx.

Again, using the list & putton can be very helpful. Discontinued series are distinguished by
a grey italic typeface; new boxes should be created using only active series.

boxdatatpa BEE

GLOBAL COMPANY DEPARTMENTAL RECENTLY USED

006. - PERSONAL INCOME TAX RETURNS [?]

008. - EMPLOYERS' WITHHOLDING STATEMENTS (EMPLOYERS' 102] [?]

=

AL INCOME TAX RETURNS REF [?

A1
L
i
I
=
f
C
r
L
T

0232. - ACTIVE AND INACTIVE SALES TAM RETURNS [?7]

025. - ACTIVE CORPORATICN TAX RETURNS (104'S) [7]

User Box Number: You will have received a set of UBNs from the State Records Center
supervisor. Each UBN is a unique combination of your department’s multi-letter code plus a
dash and a five-digit number (see also the previous description).

Type of Box: Standard (2 Position)
Storage Center: Middlesex Record Center
From Date and To Date: Enter the earliest and the latest dates of records identified in the box.

Description: Enter a brief description of contents in the box provided. If you are sending a
creation request from a district office, please add your town or city name as the first line of
the description.

The box description should be a summary of content in the box, detailed enough for other
and future agency staff members to understand the content of the box. Your agency should
also have a separate detailed internal indexing system to locate and retrieve the records
from storage; this is particularly true if your boxes contain sensitive information. Never enter
sensitive information, such as social security numbers, in box descriptions.

Please do not use the box description field for long lists of names or itemized content.
Where possible, use a range if your content is organized by date, name, or some
sequentially filing number or system
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Box Full: This is optional. We recommend leaving some space in each box to facilitate future
use and retrieval, and advise against over-packing boxes. However, if a box cannot
accommodate any additional material, you may mark it as such by checking the box.

C. WHAT HAPPENS NEXT?

At this point, you have two options. You may submit the box request to the Records Center, or
you may save it as draft.

D. SUBMIT A BOX

You may submit one box request at a time. After you click the Submit Box button,
you will get a confirmation message (“Box creation request sent successfully”), along with a
request number. You will see a Print Details button; clicking on this button will open
a pop-up window giving you a summary of the information you just submitted.

You may also click on the Create New Box link to return to the Box Creation page (you may also
do this via the top navigation menu, Creation > Box Creation Request).

You may create and submit as many other box requests as you wish, although we suggest that
large numbers of boxes are more easily created through the Box Transfer List form (VSARA-05)
found on our website.

The cookies used by the web module will fill the fields on the page with the information you had
input for the previously submitted box. This can be a helpful timesaver, as long as you make
sure that each box has its unique User Box Number and all other information is accurate for that
box.

Once a box request has been submitted via the Versatile web module, it is received and
processed by the State Records Center staff. The box is then created in the Versatile system.
Please note that the box will not be available to view until that process has been completed.

E. VIEW YOUR BOX REQUESTS

You may view the box requests you have submitted by going to the top navigation menu and
selecting Creation > My Box Requests.

Vermont State Archives and Records

Home Creation¥ Retrieval ¥ R

Box Creation Request

Box Cr My Box Requests

You will now be at the My Box Requests page. Change the Status to All or Pending on the
drop-down list and click the Refresh button. You can see up to two weeks of your submitted
box requests.
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My Box Requests
Requested Date: |04/25/2012 B to [0s/03/2013 | FE  status: |2l v
t=3 Request Box User Box Label Request Department
Number Number Number Printed? Date
226141 PENDING TX-00000 05/02/2013 TAX
FY 2011 Income tax returns (perscnal), A-F

F. SAVE AS DRAFT

The other option is to save the box request as draft. This way, you may go back and edit the
box information later, and view all your drafts before submitting them as requests.

Fill in your box information click the Save As Draft button. You will get a similar
confirmation message (“Box creation request draft sent successfully”), request number, Print
Details button, and Create New Box link to return to the Box Creation page.

You may create as many draft requests as desired.

G. VIEW YOUR DRAFT BOX REQUESTS

You may view your box requests by going to Box Creation page (even if you are not creating

another box!) and clicking on the View Saved Drafts (V1w savep DRAFTS_ ) [ytton on the top right-
hand side of that page.

A window will pop up and overlay the Box Creation page. You will see the request number,
date the draft was last saved, the UBN, Record Series, and Description.

Box Creation Page

Saved Requests ME

Request Last User Box Record Series Description
Number Saved Number

EDIT 226142 05/02/2013 TX-00000 031. - LITIGATION FILES Litigation cases fardvark - Bass from 2009 4

To the right of each draft item is a red X &. Clicking on this button will cancel and delete this
draft request.

H. EDIT A DRAFT REQUEST

To the left of each draft item is an Edit button. This enables you to submit the box, or to
make changes to the draft. You will have an opportunity to make review and edit before
submitting the box.

Clicking on Edit returns you to the Box Creation page.

If you want to make changes to the draft request, and then save the draft again for later, click on
the Save Changes button at the bottom of the page. You will get a confirmation
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message. Remember that you must return to the Box Creation page in order to access the
View Saved Drafts button.

I. SUBMIT DRAFT AS BOX REQUEST

If you are ready to submit this draft as a box request, click the Submit Draft As Box

| SUEHIT DRAFT 45 E0K ) hytton. You will get the confirmation message as you would with any
submitted box. .
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V. REQUESTING BOXES FROM THE STATE RECORDS CENTER

It is currently not possible to request boxes through the Versatile web module.

If you would like to request any boxes or files, you may use the information from your web
module search, but you must complete the online Record Request Form on VSARA'’s website.
The form asks for your name; your court, agency, or department; your customer code; the
record series, User Box Number, and record description; and whether the record(s) will be
permanently removed from the State Records Center.

Please do not submit requests without your customer code. If you do not know this code,
please consult your Records Officer.

After you submit your request, you will see a confirmation page, which may be printed for your
records. You may refer to the Procedure for Retrieving Records (VSARAO0003) for more
information.

Please remember that only designated records officers or liaisons may request and receive
records from the State Records Center.

VI. GETTING HELP

For guestions about: Contact:

User name, password and other Records and Information Management
assistance using the Versatile web module | Specialists
sos.rim@vermont.gov or 802-828-3897

Correcting box or file data and sending State Records Center Supervisor
boxes to the State Records Center sos.recordscenter@vermont.qgov or 802-828-
3280

VII.  APPLICABILITY AND AUTHORITY

This procedure is for using the State Records Center Web Module.

This is a new procedure and therefore supersedes any State of Vermont practices in existence
prior to its effective date.

The Vermont State Archivist is the statutory authority for maintaining a records center and for
this procedure on retrieving records from the records center.

This procedure was reviewed and approved by the Vermont State Archivist on June 27, 2011,
and last revised on December 4, 2013. The next review date is May 2015.
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